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Release Notes 

© Copyright Computers and Structures, Inc., 2017 

Notice Date: 2017-06-19 
 

 

This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 
Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v16.1.0 (Released 2017-04-07) 

 

Modeling 
Enhancements Implemented 

* Incident Description 

* 61501 
65676 
84360 

101355 

An enhancement has been implemented to expand the time-dependent material behavior to 
include the Eurocode 2-2004, AS 3600-2009, NZS 3101-2006 codes and the GL2000 model. Time-
dependent behavior includes creep and shrinkage strains, as well as age-dependent stiffness 
where appropriate, for concrete materials. 

* 84352 
93521 

An enhancement has been made to account for effect of reinforcing steel on the axial creep and 
shrinkage behavior of concrete in columns, braces, and walls. The users can specify the rebars in 
individual columns and walls, or they can be taken from the most recent concrete frame or wall 
design. This enhancement only affects time-dependent staged-construction load cases. This 
formulation utilizes the steel reinforcement correction factor as described in "Creep and Shrinkage 
and the Design of Supertall Buildings - A Case Study: The Burj Dubai Tower" by W.F. Baker, D.S. 
Korista, L.C. Noval, J. Pawlikowski, and B. Young (2007), ACI Special Publications, 246. 

Analysis 
Enhancements Implemented 

* Incident Description 

* 103383 An enhancement has been made to allow additional modal damping in linear and nonlinear direct 
integration time history load cases. This feature uses the mode shapes and periods from a 
specified modal load case to calculate a modal damping matrix. This matrix is restricted to the 
shape of the stiffness matrix, meaning that modal damping does not couple elements that are not 
connected. The associated modal case must use the same mass source as the direct-integration 
load case, and must be run before the direct-integration load case that uses it. Modal damping 
parameters allow the damping ratio to be constant for all modes, interpolated by period or 
frequency, or determined based on a mass and stiffness proportional coefficient. Any modal 
damping specified as additional material damping will also be included in linear and nonlinear 
direct-integration time history load cases. When modal damping is specified in a nonlinear direct 
integration time history load case, more iterations may be necessary to reach equilibrium. Modal 
damping is in addition to any proportional damping that may be specified for the direct-
integration load case. A small amount of stiffness proportional damping is recommended to 
control higher modes. The CSI Analysis Reference Manual has been updated for this topic. 
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Composite Beam Design 
Enhancements Implemented 

* Incident Description 

 102260 Composite beam design reports have been enhanced to report several additional intermediate 
quantities used for evaluating the beam vibration characteristics under walking excitation. These 
include the span and transformed moment of inertia of the supporting girder; the transformed 
moment of inertia per unit width; Ds, Dj, Dg, of the slab, beam, and girder; the coefficients Cj, Cg, 
used in evaluating the beam and girder panel widths, Bj and Bg; the panel weights Wj and Wg of the 
beam and girder; and the coefficient applied to the beam panel weight to account for beam 
continuity. 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

* 99296 An enhancement has been made to display crack widths on screen for concrete slabs. The display 
is based on calculations for a specified load case or combination according to Eurocode EC2 2004, 
using prescribed reinforcement parameters. 

Application Programming Interface (API) 
Enhancements Implemented 

* Incident Description 

 76370 The Application Programming Interface (API) has been enhanced to add functions for retrieving 
design rebar information. The following functions are provided: GetBeamLongRebarData, 
GetBeamTieRebarData, GetColumnLongRebarData, and GetColumnTieRebarData. 

 86069 
96633 

101842 
102134 
102163 
102801 

The Application Programming Interface (API) has been enhanced to make available spring property 
definitions and assignments. Point, line and area springs are covered. 

 99874 
100816 

The API functions to set and retrieve the design code (SetCode, GetCode) for steel frame design, 
concrete frame design and composite beam design have been updated to correspond to the lists 
of design codes available through the ETABS graphical user interface. 

 102056 
103770 

The Application Programing Interface (API) has been enhanced to significantly increase the speed 
of the function SapModel.Results.AreaForceShell. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 200423 The version number has been changed to v16.2.0 for a new intermediate release. 
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User Interface 
Incidents Resolved 

* Incident Description 

 91751 An incident was resolved where drawing a Developed Elevation sometimes caused an error 
condition when general grids were present in the grid system. 

 95473 An incident was resolved where moving and managing model view windows in a certain order 
could produce an error condition. Results were not affected. 

 98023 An incident was resolved where the Help window would go behind the main graphical user 
interface when accessed using the command Help > ETABS Help. This did not occur when using the 
F1 key to access the Help. 

 100161 An incident was resolved where an error would occur when trying to modify an existing load 
combination if all the load patterns that were used in load cases that were contained in the load 
combination had been deleted. 

 102152 An incident was resolved where, for a certain model, link property data had become corrupted, 
which caused an abnormal termination when viewing the Define Links form. Such models are now 
detected and corrected when opened to prevent this error. 

Graphics 
Incidents Resolved 

* Incident Description 

 96096 An incident was resolved that corrected several minor issues with DirectX graphics mode: 
1.) Overlapping shells did not display correctly in DirectX mode compared with standard graphics 
mode. 
2.) When zooming, view angles were being reset to default, which sometimes distorted the view. 
3.) Perpendicular snaps were not working in plan views. 
4.) When areas (shells) were shown in extruded view, spurious lines (triangulation lines) were 
being displayed on objects of complex form. 
5.) For some models in meter units, the selection indication did not coincide with the edges of area 
objects being selected. 
6.) Selected wall elements would sometimes appear to be selected at the wrong level. 
No results were affected by any of these issues. 

 96208 
97607 

An incident was resolved for DirectX graphics mode where area (shell) objects in shrunken view 
showed excessive shrinkage in some cases. This also affected the display of selected area objects, 
where the dashed line indicating selection showed excessive shrinkage. No results were affected. 

 96312 An incident was resolved for DirectX graphics mode where sloped area (shell) objects with more 
than four joints were displayed as being horizontal. 

 100152 An incident was resolved where using the Edit>Align command would move the joint correctly, but 
the display of lines and areas would not be updated graphically if the aligned joint merged into 
another pre-existing joint. This was a display error only and analysis results were unaffected. Using 
the Edit>Move command instead did work correctly for the display also. 

 100545 An incident was resolved where circular slabs were sometimes not visible in standard-graphics 
mode, depending on how they were drawn. When this occurred, they were still visible in DirectX-
graphics mode. No results were affected. 

 100582 An incident was resolved where the model views were always being re-scaled after executing any 
of the Edit > Extrude commands, losing the previous settings for pan and zoom. No results were 
affected. 

 102501 An incident was resolved where the lighting settings for the DirectX graphics mode were being 
reset every time the view was changed to a different aspect of the model (not just pan, zoom, or 
rotate). Now these are retained throughout the ETABS session unless explicitly changed by the 
user. 
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Modeling 
Incidents Resolved 

* Incident Description 

 76651 An incident was resolved for auto frame hinges where the "Is Extrapolated" option for behavior 
beyond point E was not working when chosen during hinge assignment. The hinge created always 
showed the "Drops to Zero" option. Results were consistent with the "Drop to Zero" option. 

 98791 An incident was resolved where the axial-force or shear-force values used to generate auto 
nonlinear hinges were not being updated after the analysis was run. This only affected hinges that 
were automatically generated and were based on ASCE 41-13 Tables 9-6, 10-7, 10-8 and also for 
which the axial or shear force was specified to be updated based on a load case or a load 
combination. Now, the hinge properties will be updated for the next time the model is unlocked and 
run again. 

 98977 An incident was resolved where the stiffness modeled for steel beams with Side-Plate (SP) or 
Reduced Beam Sections (RBS) may have been incorrect if the beams were adjacent to a slab that 
was meshed such that the beams also got meshed for analysis. When the beam was modeled as a 
single element for analysis the SP and RBS beam stiffness was correct. This would be the normal case 
when the beam is adjacent to decks or slabs modeled as membrane only. 

 100986 An incident was resolved where column PMM fiber hinges were not being updated if the column 
was assigned a Section Designer section and the section was modified after the fiber hinge 
assignment was made. This was limited to column PMM fiber hinges and Section Designer sections. 
The actual hinge properties used in analysis were viewable after the analysis was run. 

 200383 An incident was resolved where the imported properties of CoreBrace BRBs may be incorrect when 
model was started in metric units. This was obvious as the parameters K_EBE, K_EZ, and Keff were 
off by a factor of 25.4. This affected the stiffness factor used for Bolted Lug braces. Old models, 
when opened in the new version, will automatically re-import the properties and inform the user if a 
problem existed.  

Loading 
Incidents Resolved 

* Incident Description 

* 99530 
102614 

An incident was resolved where the calculated and applied loads were zero for Chinese auto wind 
loads acting on semi-rigid diaphragms when the loading was based on the computed building 
periods or mode shapes. 

* 102079 An incident was resolved where, under certain conditions, tendon loads could become corrupted 
and might result in an error condition. This happened when the tendon loads were assigned first, 
and then one or more load patterns defined before the assigned tendon load patterns were deleted 
by the user. The tendon loads were then incorrectly internally applied to the wrong load patterns, 
including possibly load patterns that no longer existed. 

Analysis 
Incidents Resolved 

* Incident Description 

 94371 An incident was resolved where Fiber P-M-M hinges in frame elements modeled as separate link 
elements (Analyze > Analysis Model for Nonlinear Hinges was set to "Model Hinges as Separate Link 
Elements") result in extra axial flexibility. The elastic axial flexibility was being double-counted only 
for the length of the Fiber P-M-M hinges themselves. This did not affect models where the hinges 
were modeled within the element (Analyze > Analysis Model for Nonlinear Hinges was set to "Model 
Hinges Within Elements"). This issue did not affect the out-of-plane bending or shear behavior of the 
element nor did it affect wall elements with wall hinges assigned. 
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* Incident Description 

 101918 An incident was resolved where a linear link property could have non-zero stiffness or damping 
coefficients present for an inactive degree-of-freedom, when it is expected that these values should 
be zero. This issue only occurred for link properties of type "Linear" in the case where the degree-of-
freedom had previously been specified as active, assigned a non-zero stiffness or damping 
coefficient, and then made inactive. 

 102409 An incident was resolved where Ritz analysis could produce zero results for very large models when 
run on machines with a large amount of RAM, typically 64 GB or more. This was due to Windows 
file-size limits that were being exceeded. When this occurred, the analysis .LOG file indicated that 
the loads were zero, and the mode shapes produced were zero. 

 103520 An incident was resolved where area edge releases would create an error condition if the release 
was applied at a triangular area element. Results were not available. 

 200320 An incident was resolved where the analysis would fail to run if any link had been assigned property 
"None". The expected behavior is that any link with property "None" would not contribute to the 
analysis model, except when changed to use an actual property during a staged-construction load 
case. Changing a link to property "None" during staged construction did work as expected. Only 
version 16.1.0 was affected by this issue. 

Frame Design 
Incidents Resolved 

* Incident Description 

 102613 An incident was resolved for concrete frame design per the Mexican RCDF 2004 code where the 
column longitudinal rebar was 100 times smaller than expected when rebar was governed by Asmin 
for Non-Sway and Ordinary columns. The percentage reinforcement was correctly shown in the 
design report but final reported longitudinal rebar was incorrect for this case. This was an obvious 
error. 

 103282 An incident has been resolved for steel frame design using Russian code SP 16.13330.2011 where 
there was a problem primarily affecting the documentation for calculation of the moment 
coefficients “m” and “m_ef” for the different boundary conditions: Fixed-Fixed, Hinged-Hinged, 
Fixed-Hinged, or Fixed-Free. The documentation has been corrected for members loaded with span 
loads and for members not loaded with span loads. The calculation of the moment coefficients “m” 
and “m_ef” should be different between section SP16 9.2.3 (to be used in calculation of “phi_e”) 
and section SP16 9.2.6 (to be used in calculation of “c”). In addition, a minor change has been made 
in the software to more accurately determine the values of “m” for different boundary conditions. 
The effect of this change is generally very small. 

 103489 An incident was resolved for steel frame design using codes "AISC 360-05" and "AISC 360-10" in 
which there was a sudden jump in the stress ratio when the member axial force switched between 
small axial tension and small axial compression. This happened when the governing combination 
given switched from AISC H1.3b to H1-2 in compression for doubly symmetric sections with very 
small minor-axis bending moment. In all cases the design result did not change between failure and 
safety. In other words, a stress ratio reported as being less than unity could have been incorrect for 
the described situation, but the correct value would also have been less than unity in such a case. 

 103597 An incident was resolved for steel frame design using code "AISC 360-10" in which the interaction 
equation AISC H1-2 was not implemented accurately. The value Mcx was taken as the available 
flexural strength considering all limit states, including lateral-torsional buckling, while considering 
the actual Cb value. However, it is now taken as the available lateral-torsional strength for strong-
axis flexure determined in accordance with Chapter F using Cb = 1.0. In Equation H1-2, Cb Mcx may 
be larger than φb Mpx in LRFD or Mpx /Ωb in ASD. The yielding resistance of the beam-column is not 
imposed on Cb*Mcx separately. This happens when the governing interaction equation as given in 
AISC H1.3b, Eqn. H1-2 in compression  for doubly symmetric sections with very small minor axis 
bending moment. The previous design results were conservative. 
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Composite Beam Design 
Incidents Resolved 

* Incident Description 

 89334 
97309 

An incident was resolved that addressed three issues affecting composite beam design for deflection 
and vibration: 
1.) The computation of the moment of inertia of the slab did not take into account the possible 
variation in deck rib width from bottom of deck to top of deck.  
2.) Girder deflection Δg was improperly being reduced per Design Guide 11 Equation 4-6 when the 
frequency of the panel was computed per Design Guide 11 Equation 3-4. The girder deflection is no 
longer reduced per Equation 4-6 when Equation 3-4 is utilized.  
3.) When the beam being evaluated is supported by two girders having different stiffness, vibration 
calculations are now based on the characteristics of the more flexible girder in accordance with a 
clarification made in the second edition of AISC Design Guide 11. Previously, ETABS based its 
calculations on the average stiffness of the two girders.  
None of these three issues affected the strength design of the beams. Documentation will be 
updated for these changes in the next release.  

 100757 An incident was resolved for composite beam design where, for the case when the user had 
specified an explicit beam section such that the percentage of composite action required to make 
the design acceptable required more shear studs than could fit the beam, the reported ratios were 
different between the interactive design form on the one hand, and the reports and tables on the 
other hand. Both reported that the beam failed, but the interactive design form displayed ratios 
based on the required percentage of composite action, along with the excessive stud crowding ratio, 
while the tables and the reports displayed ratios computed based on the properties of the steel 
section alone, without any composite action. Both the interactive design form, and the reports now 
displayed ratios based on the percentage of composite action corresponding to the maximum 
number of shear studs that fit on the beam. 

 100942 An incident was resolved which affected the design of composite beams with a user-specified shear-
stud distribution and an uneven loading where the beam maximum bending moment was closer to 
the end point of the beam than to its start point. In such a case, ETABS checked the composite 
strength and stiffness of the beam based on the number of shear studs provided between the start 
of the beam and the point of maximum moment instead of based on the number of shear studs 
provided between the point of maximum moment and the end of the beam. In addition, when there 
was more than one point load on the beam, ETABS did not check that enough shear studs were 
provided between each point load and the nearest point of zero moment. Default shear-stud 
distribution was not affected. 

 102064 An incident was resolved which affected composite beam design.  When no loads were applied on a 
given beam for certain load cases, and some of the load combinations selected for composite beam 
design contained only such load cases, ETABS would occasionally place an excessive number of shear 
studs on the beam. When this occurred, the error was obvious and the design was conservative. 
Also, a related enhancement was made which occasionally results in a slight reduction in the 
number of shear studs specified for a given percentage of composite action due to more refined 
calculation. This is most notable in the case of beams where the maximum moment occurs at the 
mid-span. The documentation for the AISC-360-05 Example 001 and AISC-360-10 Example 002 
Composite Beam Design Verification examples has been revised to include a change of one less 
shear stud for each example, with all other numbers unaffected. 
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Shear Wall Design 
Incidents Resolved 

* Incident Description 

 88235 An incident was resolved for shear wall design using the Indian IS 456:2000 code where pier design 
results were unavailable when the model was reopened in a new ETABS session. Using right click on 
pier design results in such cases would cause an error condition. 

 100362 An incident was resolved where the calculated tributary area of a shear wall pier could be incorrect 
for unevenly loaded piers. This could affect the calculated live load reduction factor (LLRF). Both the 
tributary area and the LLRF were reported in the Table "Tributary Area and LLRF", and the wall pier 
design results were consistent with the reported values. 

 101556 An incident was resolved for shear wall design per Eurocode 2-2004, CSA A23.3-14 and CSA A23.3-04 
design codes where shear wall report showed the shear force and rebar from the original load 
combinations instead of amplified shear for ductile seismic design when wall design failed in shear 
due to force modification factor specified in the wall preferences. 

 103036 
103287 

An incident was resolved for shear wall pier design where, under a certain combination of 
conditions, the forces used for shear design and boundary element design may have been almost 
twice that required. For this error to occur the pier must have been broken into multiple elements 
over the story height, there must have been multi-step cases present in the governing combination, 
and an "Envelope" or "Envelope-All" type of design was requested. Requesting "Step by Step" design 
gave the correct design. The effect of this error was over-conservative. 

* 103785 An Incident was resolved for concrete shear wall design using the ACI 318-08, ACI 318-11, and ACI 
318-14 design codes where the determination of the need for boundary-zones was incorrect for 
certain conditions. For ACI 318-08 and 318-11, the code allows checking either section 21.9.6.2 
(depth check, c < c_limit) when certain conditions are met, or else to use section 21.9.6.3 (stress 
check, fc < 0.20*fc'). ETABS design was checking both the conditions of sections 21.9.6.2 and 
21.9.6.3 to determine the need of boundary-zones. This occasionally gave an under-conservative 
determination. Now the user can choose whether to use section 21.9.6.2 or 21.9.6.3. By default, the 
design will use section 21.9.6.3. If the user chooses section 21.9.6.3, the design will compare 
extreme-end compressive stresses to 0.2*fc' and 0.15*fc' per code, as expected. On the other hand, 
if the user chooses section 21.9.6.2, the design will compare the depth of neutral axis to its limit 
given in the code, as expected. However, in this case the design will not be able to ascertain the 
conditions of "effectively continuous" and "single critical section" automatically. The design will 
assume that the user has checked those two conditions and has determined that the relevant 
section can be applied. If a boundary-zone is needed, in both cases the extent of boundary-zones 
will be determined based on the section 21.9.6.4. This incident also resolves a similar problem in ACI 
318-14, where the relevant sections are 18.10.6.2 (depth check, c < c_limit) or 18.10.6.3 (stress 
check, fc < 0.20*fc'). 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 99707 
99757 

An incident was resolved in which an abnormal termination could occur when generating a report 
for certain models. Results were not affected. 

 101804 An incident was resolved where the interaction surface and the interaction curves, accessed through 
the design details form, were not being updated when the option to display the curves was changed 
from Design Code data to Fiber Model data and vice-versa. Once the fiber model data was selected, 
the display would always show the interaction surface for Fiber Model data irrespective of which 
display option was selected. Only certain design codes were affected. Analysis and design results 
were not affected. 
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* Incident Description 

 102127 An incident was resolved in which an error could occur when displaying the composite beam design 
overwrites database table for any composite beam design code if the Restrict Beam Depth overwrite 
on a frame was set to Yes while the Restrict Beam Width was No for all beams. This was a database 
table issue and did not affect results. It could also cause an error generating a report if the 
composite beam design overwrites table was included in the report. 

 102353 An incident was resolved where the soil pressure plots were incorrect. This was a rare condition 
when either link objects were present or nonlinear hinges were specified to be modeled as links. This 
was a display error only and no other results were affected. Only version 16.1.0 was affected. 

 102467 An incident was resolved where the hinge backbone curve was not shown the first time nonlinear 
hinge results were plotted. 

Database Tables 
Incidents Resolved 

* Incident Description 

 101292 An incident was resolved where in some cases the “Hinge States” and “Fiber Hinge States” tables 
could not be displayed and a message "Error switching between tables" was given. This happened if 
triangular wall objects were present in the model. 

 101949 An incident was resolved where Shear Wall Pier Overwrites Table was showing the Rebar Index 
instead of the Bar ID for the End Bar and Edge Bar columns. This was just a display issue and no 
design results were affected. 

 102761 
103335 

An incident was resolved where Story Drifts and Story Forces were only available in the tables for 
the first tower when multiple towers were present in the model. 

 102905 
102403 
102355 

An incident was resolved where the message "Error Filling table" was shown when the Story Force 
table was requested. This was a rare occurrence and only happened when the model included an 
empty story, i.e., a story containing no objects. Only version 16.1.0 was affected. 

 102870 An incident was resolved in which an error could occur when displaying the steel frame design 
overwrites database table for any steel frame design code if the “Consider Deflection” overwrite on 
a frame was set to “Yes”. This was a database table issue and did not affect results. It could also 
cause an error generating a report if the steel frame design overwrites table was included in the 
report. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 81321 
87486 
88038 

An incident was resolved where exporting from ETABS to SAFE a floor that was connected to link 
elements would either export zero forces for the connected link elements or would cause an error 
condition. In the latter case, the export would not be performed. This issue did not affect floors 
that were not connected to any link elements. 

Application Programming Interface (API) 
Incidents Resolved 

* Incident Description 

 200114 An incident was resolved for the Application Programming Interface (API) where the function 
cLinkObj.AddByCoord was adding the coordinates of the first joint correctly using present units, 
while the coordinates of the second joint were added in the database units. Now both joints are 
being added in present units. In the common case where no API functions were being used to 
change from database units to different present units, this error had no effect. The effect of this 
error was obvious in the geometry of the generated model, and results agreed with the model. 


